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1 What’s New 

Freescale‟s CodeWarrior for Microcontrollers v10.4 integrates the development tools for the 

ColdFire
®
, ColdFire+, DSC, Kinetis, Qorivva, PX, RS08, S08 and S12Z architectures into a single 

product based on the Eclipse open development platform. Eclipse offers an excellent framework for 

building software development environments and is a standard framework used by many embedded 

software vendors.   

 

CodeWarrior for Microcontrollers v10.4 adds new features and addresses a number of defects. 

1.1 General 

1.1.1 Features 

 Improved performance by increasing IDE responsiveness. 

 Improved startup performance by optimizing debug database loading. 

 Extended Memory Browser‟s memory import /export actions to handle word 

addressable memory spaces. 

 Added ability to export register values in human readable format (CSV ASCII). 

 Updated Register View to display leading 0's in binary and hexadecimal format. 

 Watchpoint instances are persistent after restart. 

 Added ability to reconfigure Tracepoints during a debug session. 

 Ensured service packs install in one step. 

 Device Initialization replaced by Processor Expert Hardware Perspective. 

 Processor Expert automatically restores project upon startup. 

 Added ability to disable code generation in Processor Expert for CPU.c and 

CPU.h files.  

 Added new project option for subdirectory Static_Code. 

 Added ability to select a different package in CPU Component Inspector and 

Processor view. 

 Added F2 hot key in Project Panel to allow a component to be renamed.  

 Added “Open File” command to Processor Expert component popup-menus to 

list generated files for selected component. 

 Added “Remove Component” command in Processor Expert peripheral 

component pop-up menu in Target Processor view.  

 Simplified New Project Wizard's Connections Dialog by listing only one entry for 

P&E's Cyclone MAX, Cyclone Pro and Tracelink interfaces 

 Removed 'USB' from the debug configuration name for P&E: "Cyclone 

PRO/MAX" and "Tracelink" New Project Wizard projects 

 Added Target Power ON/OFF functionality to Launch Configuration Dialog (LCD) 

for P&E's Multilink Universal FX and Tracelink interfaces.   

 Added Windows XP 64-bit driver support for P&E USB interfaces  

 Added new items to the popup menu to allow reordering of property groups "List 

of items" and "List of items defined in file". 
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1.1.2 Bug Fixes 

 ENGR00208664: "Restore Defaults" button works correctly in Disassembly 

preference page. 

 ENGR00227872: Updated processor component hints in Processor Expert 

Components Library view to list part number, pin count and package information 

for derivatives supported. 

 ENGR00234132: Variables View shows correct value of "char" variable in 

decimal format. 

 ENGR00237202: Components in User Folders are no longer moved to Processor 

Expert Embedded Components folder when they are  disabled/enabled. 

 ENGR00240738: Addressed Processor Expert CAN component code generation 

defect. BufferIdx range test in the GetRxFrameState() method has been changed 

to: 

 if (BufferIdx > DeviceDataPrv->MaxBufferIndex) { 
   ... 
 } 

 ENGR00243564: A warning is displayed if a breakpoint export file path is invalid. 

 ENGR00243590: Update existing breakpoints option works as expected when 

importing breakpoints. 

 ENGR00243874: Added tool tip and name for the "Go to address..." button in 

Disassembly Rendering in Memory View. 

 ENGR00251319: Able to create attach debug configurations for mqx examples. 

 ENGR00241807: Updated IDE to generate correct build make files.  

 ENGR00252164: Consolidated error messages for Memory Browser View when 

setting a custom number of columns. 

 ENGR00252377: No error message is displayed when clicking "CodeWarrior for 

MCU" in “Tips & Tricks” 

 ENGR00254380: Addressed problem with importing and exporting breakpoints 

 ENGR00253092: Output renaming is handled correctly for projects that 

unconditionally rename output files.  

 

1.1.3 Documentation 

 Getting Started 

o Microcontrollers V10.x Quick Start 

o Microcontrollers V10.x Profiling and Analysis Quick Start  

o Ethernet TAP Probe Quick Start 

 Common Manuals 

o CodeWarrior Common Features Guide  

o Microcontrollers V10.x Profiling and Analysis Users Guide  

o HCS08/RS08/ColdFire/Kinetis/PA MISRA Exceptions Reference Manual  

o EWL C Reference Manual  

o EWL for C++ Reference Manual Processor Expert Manuals 

 Processor Expert Manuals 

o Processor Expert User Manual  

o Processor Expert Components Manual   

o MQX Lite Real-Time Operating System User Guide  

o Macro-processor Language Reference Manual  

http://127.0.0.1:1269/help/nav/0_10_6
file:///D:/2013%20-%20WORK/10.3_UPDATE_02/Document_Component/docs.mcu_eclipse_win_v10.3_UPD02_130425/MCU/Help/PDF/Macro_Language_Reference_Manual.pdf
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 Run Control Manuals 

o Ethernet TAP Users Guide  

o USB TAP Users Guide  

o Open Source BDM-JM60 Users Guide 

 Targeting Microcontrollers 

o Microcontrollers V10.x Targeting Manual 

o Porting Freescale ARM Compiler-based Projects to use ARM GCC 

 Application Notes 

o Adding Devices(s) to the CodeWarrior Flash Programmer  

o How to Write Flash Programming Applets 

o Using CodeWarrior Diff Tool 

 Microcontrollers 10.x FAQ Guide 

1.2 ColdFire/ColdFire+ 

1.2.1 Features 

 Removed "com.freescale.core.ide.cdt.errorParsers.GCCErrorParser" error parser 

from ColdFire tool chain to improve performance. 

 Register coloring automatically enabled when "fralloc" is used in inline assembly 

code. 

 Added Advanced Programming options for V2-V4 ColdFire devices. 

o Preserve FLASH range  

o Choose alternative FLASH programming algorithm 

 Removed "com.freescale.core.ide.cdt.errorParsers.GCCErrorParser" error parser 

from ColdFire tool chain to improve build performance. 

 

1.2.2 Bug Fixes 

 ENGR00174158: Added new Processor Expert method which allows transmit 

buffer priority to be set for FreescaleCAN. 

 ENGR00231314: Compiler displays an error message when including a file 

which recursively includes itself without #ifndef…#define sequence. 

 ENGR00243189: Clean project does not fail with "Exec" projects. 

 ENGR00242360: Write to external MRAM memory is supported for ColdFire 

V2V3 and V4 architectures. 

 ENGR00252260: MCF51AC256 project occasionally hangs after software reset. 

Updated Processor Expert to remove erroneous write of DIV32 bit in the PLL 

initialization code when FLL is active. 

 ENGR00252423: CPU generated code updated to stop at main function in a 

Processor Expert enabled project when using MCF52211_Internal Flash 

configuration. 

 ENGR00252536: Tracelink firmware updated to address Codewarrior 

communication issues when trace is enabled. 

 ENGR00255341: Correct code generated for address computation when only 

register coloring is enabled. 

 ENGR00256055: Fixed configuration when TWR-MCF51QM/TWR-MCF51JF 

and MQX RTOS adapter are enabled in BSP. 
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 ENGR00256373: Added error message when GNU compiler is incorrectly used 

for ColdFire+ derivatives. 

 

1.2.3 Documentation 

• Manuals 

o ColdFire Assembler Manual  

o ColdFire Build Tools Reference Manual  

• Application Notes 

o Configuring Compiler Options for Optimal Performance of ColdFire Devices  

o Relocating Code and Data Using the CodeWarrior LCF for ColdFire 

Architecture 

1.3 Digital Signal Controller (DSC) 

1.3.1 Features 

 Added support for C++ language in Build Tools.  

Note: Limitations include: 

o Incomplete support for RTTI. 

o Incomplete support for Templates. 

o No Exception Handling support. 

 DSC tools (Assembler/Compiler/Linker/Preprocessor/Disassembler) use args file 

passing mechanism. 

 Removed "com.freescale.core.ide.cdt.errorParsers.GCCErrorParser" error parser 

from DSC tool chain to improve build performance 

 Added Advanced Programming options for DSC devices. 

o Preserve FLASH range 

o Choose alternative FLASH programming algorithm 

 Added Processor Expert support for MC56F82xxx devices            

 Added static code generation to Processor Expert for MC56F82xxx init 

components. 

 Enabled by default new (-v3) „56800EX' compiler option in MC56F82xxx and 

MC56F84xxx New Project Wizard projects. 

 

1.3.2 Bug Fixes 

• ENGR00176414: Added support for quadrature decoder for TMPRA0 and 

TMPRA1 by component PulseAccumulator_LDD for MC56F825x microcontroller. 

• ENGR00229650: Added signed mode for Processor Expert 

Init_eFlexPWM_VAR0 component with PDD2 static support. 

• ENGR00231323: Fixed compiler issue when including a file which recursively 

includes itself. 

• ENGR00235878: Fixed errors when “Clean” is performed with DSC library 

projects. 

• ENGR00238318: Fixed linker errors for OBJECT command usage in DSC Linker 

Command File. 

• ENGR00239949: Added ability to search in multi-byte addressable memory 

spaces (e.g. "Program" or "Data Word") 

• ENGR00240458: Fixed compiler crash issue for test cases with '__restrict' 

usage. 



CodeWarrior Development Studio for Microcontrollers, v10.4 

 

 

April 30, 2012  6 

 

• ENGR00240207: Fixed confusing source code dump issue in the disassembly 

generation for final elf files. 

• ENGR00250824: Fixed linker command file to avoid download stuck at 99% 

when using MC56F84763 and MC56F84789 microcontrollers. 

• ENGR00251463: Added “Always Erase FLASH” option so P&E MultiLink can be 

used to program/debug  MC56F83xxx devices with previously protected FLASH 

memory.  

• ENGR00252619: Option „ -chkasm „ on command line and „Check Inline 

Assembly for Pipeline‟ in IDE work for V3 / 56800EX core  

• ENGR00253128:  Addressed "Flash file to target" problem 

• ENGR00256458: Added SetChanOffset() function for ADC component on 

MC56F84789. 

 

1.3.3 Documentation 

• DSC Assembler Manual  

• DSC Build Tools Manual 

1.4 Kinetis 

1.4.1 Features 

 Updated ARM Ltd. GCC compiler to version 4.7.3 and integrated with EWL 

libraries. 

 Added support for variables stored in more than one register to complete -O0 

support for GCC ARM compiler. 

 Added argument file support for GCC-ARM 'Linker (C/C++)' for application 

projects. 

 Added argument file support for 'Archiver' tools for library projects. 

 Added option to ARM GCC compiler to allow users to enable/disable listing file 

generation. 

 Added version and build number for ARM Ltd. GCC Build Tools to display in the 

Help -> About dialog box. 

 Improved FSL ARM compiler stability and usability 

 Removed "com.freescale.core.ide.cdt.errorParsers.GCCErrorParser" error parser 

from FSL ARM tool chain to improve performance. 

 Added full support for KL02Z, KL16Z, KL26Z, KL36Z, KL46Z, K11D, K21D and 

K61F devices including Processor Expert support. 

 Added trace and profile support for K11D/K12D 50MHz devices 

 Improved MTB trace buffer setup 

 Added ability to set/change Tracepoints during a debug session. 

 Updated OpenSDA DEBUG application to v1.05 

 Added trim support to Launch Configuration Dialog for Kinetis L series devices. 

 Defined a default semi hosting macro (-D__SEMIHOSTING) for a „Debugger 

Console‟ [ARM GCC] I/O project selection. 

 Added MQX-Lite support for Kinetis K Series devices 

 Added support for MQX 4.0 including MQX New Project Wizard and task aware 

debug (TAD) 
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 New Project Wizard 

o Added 'Exceptions Support' in [ARM GCC] 'C++' generated projects 

o Added ability to disable listing file generation for [ARM GCC] Kinetis 

projects 

o Added OpenSDA interface support for Kinetis MK1x and MK2x 50 MHz 

devices  

 MQX-Lite New Project Wizard 

o Added Kinetis K families/devices. Both FSL-ARM proprietary compiler and 

ARM Ltd.GCC compiler are supported for Kinetis K Series families. The 

default compiler is ARM GCC. 

o Added ability to disable listing file generation for [ARM GCC] Kinetis 

projects  

o Added OpenSDA interface support for Kinetis MK1x and MK2x 50 MHz 

devices 

 

1.4.2 Bug Fixes 

 ENGR00211209: GCC ARM compiler generates correct debug location for local 

variables at optimization -O1 or higher. 

 ENGR00219043: Addressed Processor Expert Serial_LDD component 

documentation error. 

 ENGR00235129: Addressed code generation error for Processor Expert 

Ethernet_LDD component. A missing condition was added to the component's 

driver to avoid the use of a disabled clock configuration. 

 ENGR00236417: Added extern "C" in generated vectors.c so Processor Expert 

can be used with Kinetis C++ projects. 

 ENGR00237210: Debugger able to stop a running K60F device. 

 ENGR00239108:  Updated Processor Expert serial_LDD component for 

KL25Z128 to generate correct baud rate code for Uart1. 

 ENGR00242264: Correctly passes argc/argv argument to the debugger. 

 ENGR00243412: Addressed External Bus configuration error in Processor 

Expert generated code. 

 ENGR00243544: P&E Multilink, Cyclone and Tracelink run control devices 

support FLASH programming for Kinetis MK70 Rev 1 and Rev 2 silicon. 

 ENGR00244393: Updated Make for GCC to react to changes in header files 

done in an external editor 

 ENGR00250486: Fixed misspelled NMI module on KL25Z CPU properties. 

 ENGR00250837:  Updated Processor Expert SPIMaster_LDD component for 

Kinetis 100MHz K Series devices. Generated code sets PCS field of the SPI 

PUSHR register to correct values, so correct chip selects are enabled. 

 ENGR00252015: Fixed data timeout error handling during data transfer, 

removed skipping of card status reading when using LDD_SDHC component. 

 ENGR00252057: Fixed Init_TPM period calculation. Item description improved. 

 ENGR00252061: Fixed missing DMA bit initialization in Init_TPM. 

 ENGR00254445: Condition in driver code updated so code is not removed from 

void IntFlashLdd1_OnOperationComplete(LDD_TUserData *UserDataPtr) 

method if only one SetXXXFlash method is enabled. 
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 ENGR00256202: Processor Expert Serial_LDD component error messages for 

shared mode settings extended to be more descriptive. 

 ENGR00256760: Fixed typo in Processor Expert Kinetis CPU component NMI 

Interrupt comment. 

 ENGR00256888: Fixed Processor Expert Serial_LDD component pin settings for 

UART0 on FRDM-KL05Z. 

1.4.3 Documentation 

• Manuals 

o Kinetis Assembler Manual  

o Kinetis Build Tools Reference Manual  

• Application Notes 

o Configuring Compiler Options for Optimal Performance of Kinetis Cores  

o CodeWarrior Linker Command File (LCF) for Kinetis 

1.5 Qorivva/PX 

1.5.1 Features 

 Improved compiler stability and usability 

 Added new load store optimization 

 Added simultaneous debugging of cores with identical register group names but 

with different content to support heterogeneous multi-core debugging. 

 Support for MQX 4.0. including MQX New Project Wizard and task aware debug 

(TAD) 

 Removed "com.freescale.core.ide.cdt.errorParsers.GCCErrorParser" error parser 

from Qorivva/PX tool chain to improve performance. 

 

1.5.2 Bug Fixes 

 ENGR00243411: Disabling breakpoints in current context is supported when 

debugging MPC56xx programs in FLASH. 

 ENGR00243417: Setting MPC56xx hardware breakpoints using "All Context" is 

supported. 

 ENGR00252060: The debugger does not lose connection, if “Step Over” an MQX 

infinite loop. 

 

1.5.3 Documentation 

• Manuals 

o Power Architecture Processors Build Tools Reference Manual  

• Application Notes 

o Optimal Build Tools Settings for Power Architecture e200Core 

o CodeWarrior Linker Command File (LCF) for Qorivva/PX 

1.6 RS08/S08 

1.6.1 Bug Fixes 

 ENGR00174158: Added new Processor Expert method which allows transmit 

buffer priority to be set for FreescaleCAN. 
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 ENGR00232471: Processor Expert MCU Target View updated for S08GT16 

LQFP and PDIP packages to show the correct location of pin #1. 

 ENGR00238908: Processor Expert added Init component support for all S08PT 

peripherals. 

 ENGR00240535: Updated PWM component to remove unnecessary limit on 

minimal timer ticks, so list of calculated timing values is complete. 

 ENGR00241888: Corrected close() implementation for the Customize 

Perspective Dialog. 

 ENGR00243258: Processor Expert generates correct code for S08PT16 FTM 

module. 

 ENGR00252918: Added -Lm assembler option to enable correct include file 

tracking by the make system. 

 ENGR00253381: Addressed issue importing and executing flash task. 

 ENGR00254944: Updated IDE to guard against empty build artifact type value. 

 ENGR00255156: To set logging at workspace level  globalBuildConsole should 

be used instead of buildConsole. The proper command is 

org.eclipse.cdt.ui/globalBuildConsole/keepLog=false. 

 

1.6.2 Documentation 

• Manuals 

o HC(S)08/RS08 Assembler Manual  

o HC(S)08 Build Tools Reference Manual  

o RS08 Build Tools Reference Manual  

o HCS08/RS08 Build Tools Utility Manual 

• Application Notes 

o RS08 Upper Memory Access 

o Configuring Compiler Options for Optimal Performance of HCS08 Cores  

o Configuring Compiler Options for Optimal Performance of RS08 Cores 

1.7 S12Z 

1.7.1 Features 

 Extended 64-bit floating point support to enhance precision and compliance with 

the IEEE754 standard (rounding, comparisons, flags/exceptions) 

 Extended 32-bit floating point support to enhanced precision and compliance with 

the IEEE754 standard (rounding, comparisons, flags/exceptions) 

 New Project Wizard provides two separate sets of 32/64-bit floating point options: 

optimized vs. compliant. 

 Compiler supports stack consumption estimation. 

 Compiler provides information so linker will not link object files compiled with 

different memory models 

 Libraries are linked, based on the memory model (small/medium/large) and 

language selection (Asm/C and C++) 

 '-Lm' option added to assembler's command-line to generate dependency 

tracking 

 Enforce operators added to inline assembly and assembly code (both in compiler 

and in assembler). Memory and immediate operands can be forced to a certain 
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addressing mode using enforce operators. In this case the compiler doesn't 

generate code for the shortest addressing mode, but the specified mode. 

 "-asm_enhance" command line option added to enable inline assembly data 

optimizations and stack effect computation.  

 Flash Programmer provides the ability to unsecure a device via mass erase 

when using a P&E Microcontrollers Multilink or Cyclone Pro to connect to the 

device.  The mass erase functionality can also be used to unprotect the device. 

 Added support for MM9Z1x638, VFP64 and VHY64 devices 

 Added Processor Expert support for VFP64, VHY64, VM32 silicon version 2.0, 

VMC64, VMC128, VML64, VML128. 

 Run control support for S12Z architecture added to Tracelink. To use Tracelink 

with a s12z device: create a Cyclone Pro or Multilink project, edit Connection in 

Debug Configuration dialog and select USB- or Ethernet-based Tracelink. 

connection 

 

1.7.2 Bug Fixes 

 ENGR00174158: Added new Processor Expert method which allows transmit 

buffer priority to be set for FreescaleCAN. 

 ENGR00177806: Added property to modify LDOK bit in Init_PMF_HCS12 

component. 

 ENGR00242040: Implemented Enable/Disable Event optimization in TimerInt, 

TimerOut, FreeCntr components. 

 ENGR00251371: S12Z compiler generates correct ASM code with opt=2 or     

opt =3 when an inline assembly code function accesses local variables. 

 ENGR00252358: Corrected handling of inline assembly constant when passed 

with "$" prefix. 

 ENGR00255608: Added missing referenced TPS files to Init_RVA_HCS12 

component. 

 ENGR00255801: Fixed “Enable PE for existing C project” feature for S12Z. 

 Updated variable debug information to handle situations where stack pointer is 

modified outside the function's prologue or epilogue. 

 Fixed accepted/encoded inline assembly code 

 Fixed stack consumption estimation to work with C++ code 

 Fixed return issue for functions with return values (according to the prototype) but 

with nothing returned (especially in assembly) 

 

1.7.3 Documentation 

• S12Z Assembler Manual  

• S12Z Build Tools Manual 

1.8 Component Development Environment (CDE) 

1.8.1 Features 

 Component Development Environment operates at the Community level if no 

license is found. The Community license level allows you to create and freely 

distribute software components for non-commercial use. 
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1.8.2 Bug Fixes 

 ENGR00250998:  When creating new component project, Component icon is  

created successfully  

 ENGR00251196 - HtmlDocumentation_Hint in new event is filled with %hint by 

default  

 ENGR00250845 - OK button works correctly in "Select Group" dialog when 

adding method or event groups  

 ENGR00238653 - Error message correctly disappears when changing from 

"Local Interface" type to "Global Interface" type  

 ENGR00241822 - RTOS button is enabled and if there is no valid license user 

will be notified by error message. 

 ENGR00251197 - "Delete Item" button is only active when there are items to 

delete.   

 ENGR00241577 - The size of dialog is correct when performing copy project  

 ENGR00251195: Able to create component project when change from "Device 

Component" to "Software Component"  

 ENGR00253766 - Order of folders under component is now Properties, Methods, 

Events, PropertyTypes, TypesDefinition, Constants, ItemDefinitions, 

RegisteredOnInterface, Revisions) 

 ENGR00241830 - Premature validation with "This field cannot be empty" dialog 

deleted. 

 ENGR00236252: Only have to specify “Size” for Array type. No longer have to 

specify low and high indexes.  

 ENGR00243298: No error notification for Array type with size. 

 ENGR00255726 - Event Module added to show basic properties.  

 ENGR00255565 - Embedded Component is shown in Component view when 

created.  

 ENGR00256094: Addressed Component Information IconCombo editing issue. 

 ENGR00256714: Able to generate project with inh. Component.  

 ENGR00256835: Added combo condition to provide ability to edit imported ADC 

component from package. 

 ENGR00256089: Fixed icon combo/selection in wizard and info page.  

 ENGR00257126: Addressed issue with removing items in Components view  

 ENGR00255817: Addressed exception that occurs when creating a new 

component with sharing  

 ENGR00256772 - Search as you type works in Inheritance Wizard as expected  

 ENGR00256650 - "Problem Occurred " dialog is not displayed  when performing 

rename project with spaces in front of name 

 

1.8.3 Documentation 

 Component Development Environment Getting Started  

 Component Development Environment User Guide  

 Component Development Environment RTOS User Guide  

  

http://127.0.0.1:1269/help/nav/0_10_2
http://127.0.0.1:1269/help/nav/0_10_4
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2 System Requirements  

2.1 Recommended Configuration 

 2.6GHz Pentium® compatible processor or better  

 4GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware 

 Ethernet port for communications with target hardware (optional) 

2.2 Operational Minimum Configuration 

 1.8GHz Pentium® compatible processor or better  

 2GB RAM  

 20GB (When installing full product or updates for all architectures) 

 400MB on Windows system disk  

 DVD drive for installation  

 USB port for communications with target hardware  

2.3 Host Operating System Support 

 Microsoft® Windows XP 32-bit and 64-bit (Professional Edition) 

 Microsoft Windows 7 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

 Microsoft Windows 8 32-bit and 64-bit (Home Premium Edition and Professional Edition) 

3 Product WEB page 

CodeWarrior Development Studio for Microcontrollers v10.4 is available for download at 

http://www.freescale.com/cwmcu10. 

4 Installation and Licensing 

To install CodeWarrior Development Studio for Microcontrollers v10.4, double-click the installation 

package and a wizard will guide you through the installation process.  An Evaluation license is 

automatically installed with your product and you do not need to register it. This license allows you to 

develop projects as Professional Edition during the evaluation period. After 30 days, the license 

works as a Special Edition license (free permanent, but feature limited) which supports unlimited 

assembly code, up to 64KB of C code for S08/RS08, V1 ColdFire/ColdFire+, Kinetis L Series 

derivatives; up to 128KB of C code for V2-V4 ColdFire and Kinetis K Series derivatives; and up to 

512KB of C code for Qorivva and PX derivatives. 

 

New functionality including support for new devices can be added to CodeWarrior Development 

Studio for Microcontrollers v10.4 (CW MCU v10.4) with service packs, updates and patches. Service 

packs add specific support for new devices. Updates and patches correct software defects and add 

general functionality affecting more than one device family. New support can be added directly from 

the Internet or from a downloaded archive. If your computer is connected to the Internet, select 

Install New Software in the Help Menu and all available updates will be displayed. If your computer 

does not have Internet access, you can download the archive that contains the service pack, update 

http://www.freescale.com/cwmcu10
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or patch you need from CW MCU v10.4 Update & Patches and follow the Service Pack Updater 

procedure posted on the site.  

 

Note: Before installing updates, service packs or patches, select Restart in the File menu to perform 

a CodeWarrior restart. This will ensure all processes (e.g. debugger shell) are closed. CodeWarrior 

should NOT be used during the installation process. 

5 Technical Support  

All CodeWarrior issues are tracked through Freescale's normal Service Request Process. To report 

feature requests (enhancements) or defects for CodeWarrior Development Studio for 

Microcontrollers v10.4, please submit a Service Request.    

 

1. Go to http://www.freescale.com/support  

2. Log in.  

3. On the resulting MyFreescale page, click Enter a Service Request  

4. Choose category Software Product Support  

5. Choose topic CodeWarrior  

6. Click Next.  

7. Provide the required information. You may attach a file up to 10 MB in size to the SR. You may 

also specify email addresses of people you would like to keep notified on the progress of the SR. 

Separate multiple email addresses with commas. Depending on the nature of the issue (defects 

require more information) you may need to provide some or all of the information listed below. 

 Type:  pick from Question, Defect Report, Feature Request 

 Subject:  be short and descriptive 

 Description:  details your question, defect or feature request 

 Severity:  choose from Medium, High, or Critical 

 Target:  specify the hardware microcontroller/microprocessor family involved 

 Reproducibility: choose from Always, Rarely, Sometimes, Unknown 

 Steps to Reproduce: be precise so we can reproduce the problem 

 Expected Result: what you expected to happen 

 Observed Result: what actually happened 

 Product: CW for Microcontrollers 

 Root Cause/Nature: enter root cause (e.g. software defect) 

 RTOS: enter the RTOS being used (e.g. NA)  

 Major: 10 

 Minor: 3  

 Patch: N/A 

 Component: enter component (e.g. Debugger) 

 Host: enter host operating system 

 

Please note:  

The Product field must be set to CW for Microcontrollers. This will allow the appropriate 

Freescale personnel to find SRs related to this project very easily, follow up as needed, report on 

them, and gather statistics on how the product is doing.  

http://www.freescale.com/webapp/sps/site/overview.jsp?code=CW_UPDATES_MCU_10_3
http://www.freescale.com/support
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8. When finished, click Submit.  

After Submit is selected, a confirmation page will be displayed with the SR number. You will also 

receive a confirming email sent to the address specified in your Freescale account. 

 

Appendix A:  Known issues and Workarounds 

Issue ID Description 

General  

ENGR00250596 Description: When selecting Filter Trace, an incorrect dialog box appears. 
Workaround: None. This feature is not functioning at this time. 

ColdFire/ColdFire+  

ENGR00236318 Description: P&E Tracelink captures very little trace data for MCF52259. 
Workaround: None. Due to a hardware issue with MCF52259, trace does not 
operate properly with P&E Tracelink. 

ENGR00243601 Description: The correct values are not displayed for Avg Inclusive, Percent 
Callee, Percent Caller in the Performance View when Time Unit is changed 
from cycles. 
Workaround: When changing time units in Performance View, use the pie 
charts tooltips. They display the correct percentages. 

ENGR00243932 Description: Data Trace is collected and shown in Trace View even when 
Trace Data Values are disabled for Read Data and Write Data with P&E 
Tracelink. 
Workaround: None 

ENGR00259872 Description: Configuration of external bus does not work properly in Processor 
Expert. External memory area configured using "ChipSelect" property in the 
processor component (properties CS0 - CS5) is not displayed in the Memory 
map. External memory block cannot be specified. 
Workaround: Do not specify external memory blocks in the processor 
component. The external memory areas must be configured manually in the 
linker file. 

DSC  

ENGR00226381 Description: Reading a word from external RAM (memory space above 0x7fff) 
does not work correctly with Small Data Model. 
Workaround: Small Data Model only allows access up to 0x7fff. Use Large 
Data Model if extended data access is required. 

ENGR00259771 Description: Values in Processor Expert timing dialog are incorrect to 
implement chained counters for MC56F84xxx devices. 
Workaround: There is no work around for this issue. Do not use Processor 
Expert to set up chain counters. 

ENGR00259871 Description: Software breakpoints for MC56F82xxx projects with static init 
support for C++ do not work with USB TAP.  
Workaround: Do not use USB TAP to debug MC56F82xxx projects. 

Kinetis  

ENGR00238462 Description: Enabling MTB trace does not work through project properties.  
Workaround: Set the trace/profile options though the debugger settings. 
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ENGR00244296 Description: When building a Kinetis project for the K20 and the Freescale 
USB Stack, there is an internal compiler error generated, "constant value not in 
range for Thumb2 instructions." The project is for K20DX128VLH5 and uses the 
Freescale USB Stack 4.0.3. 
Workaround: Disable optimization, use –O0. 

ENGR00251403 Description: Timestamps greater than zero are reported in Trace Data View 
when Timestamps are disabled for ITM trace. The development platform is a 
Tracelink connected to a K21DN512 board. 
Workaround: None. When timestamps are disabled, the timestamps in the 
Trace Data View should be zero. This issue will be fixed in a future release. 

ENGR00251512 Description: Timestamps are reset to zero in Trace Data View when a 
breakpoint is hit and the debug session is resumed. The development platform 
is a Tracelink connected to a K21DN512 board. 
Workaround: None. When a debug session is resumed, the timestamps in the 
Trace Data View should not be reset to zero. This issue will be fixed in a future 
release. 

ENGR00251760 Description: Unable to build the CMSIS libraries as delivered from the web. 
The build system is limited to an 8KB command line length. When including the 
CMSIS library, this line length is exceeded. 
Workaround: List all the objects being linked in a @argument file or split the 
library into several sub-archives. 

 Description: Large Kinetis projects take a long time to build with ARM GCC 
compiler. 
Workaround: Disable the Freescale GCC error parser in Project Proprieties      
->C/C++ Build->Settings->Error Parser Tab. This will prevent the parser from 
processing build console output and redirecting error messages to the 
“problems view.” 

Qorivva/PX  

ENGR00229909 Description: Can't access core_0 after issuing a single core reset via the on 
demand dialog when the project is configured for single (core_0) operation. 
Workaround: When the project is configured for single (core_0) operation, 
RESET causes the entire processor to be RESET. The core_0 reset occurs and 
core_1 is also held in RESET. To utilize single core debug functionality 
configure the project in Launch Configuration Dialog to debug both cores. 

ENGR00233491 Description: During RAM debug sessions on multi-core Qorivva devices, an 
issue arises when a software breakpoint is set and only enabled for one core. 
The PC is not properly updated following resume and halt commands. 
Workaround: Ensure that a given software breakpoint is enabled in both cores, 
which is the default setting. 

ENGR00238029 Description: Breakpoints/debugger stepping functions do not work when code 
is located in Shadow Flash. 
Workaround: The Shadow Flash is meant for silicon and system configuration 
storage. The ability to run code from this memory space is possible, but not 
recommended. The Shadow Flash does not have the appropriate hardware 
support to allow single stepping or setting break points. 

ENGR00258314 Description: A project can be mis-configured if “All configurations” is selected 
accidentally in C/C++ Build -> Settings. Linker parameters '-romaddr' and '-
rambuffer' will not be included in the project settings. 
Workaround: Do not select “All configurations” when modifying build 
configurations.  If “All configurations” is accidently selected, select “Cancel” and 
restart the build configuration process. 
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ENGR00258378 Description:  After “Multicore Restart” the wrong instance of a breakpoint gets 
disabled. 
Workaround: Enable the instance from Breakpoints View. Click the check-box 
in front of the instance to enable the breakpoint. 

ENGR00257998 Description: Cannot add a Memory Monitor after “Multicore Restart.” 
Workaround: Use "Terminate and Relaunch" in Debug View context menu 
instead of “Multicore Restart.” 

RS08/S08  

ENGR00184839 Description: Debugger Flash programming will fail if the application 
downloaded has overlapping memory ranges. The debugger will display a 
"Failed to resume target process" error. 
Workaround: Check the linker options and remove the -WmsgSd1100 -
WmsgSd1912 options so the linker reports overlapping memory ranges. 

ENGR00243112 Description: Function chart in Performance View doesn't update when clicking 
next/previous function buttons. 
Workaround: Select the desired function directly from the functions table. 

ENGR00252493 Description: CodeWarrior stops working when select Start/Stop Trace button 
with P&E Full Chip Simulation.  
Workaround: None. Software Analysis does not support simulators. Do not 
enable trace when using P&E Full Chip Simulation. 

MQX  

ENGR00195659 Description: When importing MQX v3.8.1 projects for ColdFire boards, some 
sub files may not be located and cause an error message to be displayed 
Workaround: Locate the file(s) or edit the source lookup path to include the 
correct path to the MQX installation. 

ENGR00210485 Description: MQX 3.8.1 projects for PXN2020, PXS2010 and PXS3020 boards 
may not operate correctly (e.g. not stop at main function). 
Workaround: Manually set the path to the initialization files in the CW 
installation - {MCU10.3Beta2Dir}\MCU\PA_Support\Initialization_Files\px.   
This issue is addressed in MQX 4.0. 

 

  



CodeWarrior Development Studio for Microcontrollers, v10.4 

 

 

April 30, 2012  17 

 

Appendix B:  MQX Integration 

1 MQX v3.8 was developed to work with CW MCU v10.1. It is not supported in CW MCU v10.4. 

 

2 MQX v3.8.1 was developed to work with CW MCU v10.2. It has been tested and confirmed to work 

with CW MCU v10.4.  

 
3 MQX v4.0 was developed to work with CW MCU v10.2 and CW MCU v10.4. 

 

4 MQX Lite RTOS is integrated with CW MCU v10.4. It supports Kinetis L Series devices. To create a 

new project with MQX-Lite RTOS do the following: 

 

 Select New MQX-Lite Project in the Commander View. 

 Name the project. 

 Select a Kinetis device in the Devices dialog 

 Select a connection in the Connections dialog 

 Select preferred language and build tools options 

 A Processor Expert project will be created with the MQX-Lite component. 

 Configure the MQX-Lite component. 

 Add and configure other peripheral components to the project. 

 Select Generate Processor Expert Code icon in the Components View. 

 Add your application code to the project. 

 

5 MQX 3.8.1 task-aware debug is integrated with CW MCU v10.4 and will be automatically installed. 

  

6 MQX 4.0 task-aware debug is integrated with CW MCU v10.4 Update 1.0.0 and will be automatically 

installed. This plug-in can be used with MQX or MQX-Lite.  
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Appendix C:  Performance Considerations 

CodeWarrior Development Studio for Microcontrollers v10.4 is a powerful tool chain. The following 

suggestions will help keep the CodeWarrior tools running at a respectable performance level. 

 

1 To maximize performance, the CodeWarrior tools should be installed on a computer with the 

recommended system configuration. While the tools will operate on a computer with the minimum 

configuration,  the limited hardware will restrict its ability to function at desired performance levels. 

2 Close unused projects. Eclipse caches files for all open projects in the workspace. If you need 

multiple projects open, try to limit the number of projects to no more than 10. 

3 The Eclipse IDE provides several options that provide user assistance tools. These options, however,  

use memory and cpu bandwidth. If performance is slow and you do not need these options, turn them 

off.  

 Scalability options configure how eclipse deals with large source files. 

o Scalability options 

 Editor live parsing: impacts parsing while typing, Outline view, semantic highlighting, 

folding, etc. 

 Semantic highlighting: C/C++ identifiers are colored 

 Syntax coloring: coloring of keywords, comments and literals 

 Parsing-based content assist proposals: content assist proposals which require parsing 

the file  

 Content assist auto activation: content assist activated automatically on trigger 

sequences, like '.', '::' or '->'. 

o To disable: 

 Click menu „Windows‟ -> „Preference‟  

 Expand „C/C++‟ -> „Editor‟ -> „Scalability‟ 

 Uncheck „enable scalability options‟ 

 Content Assist Auto Activation can reduce the number of keystrokes a developer must type 

to create code. The Content Assist plug-in consists of components that predict what a 

developer will type, based on the current context, scope and prefix. 

o To disable: 

 Click menu „Windows‟ -> „Preference‟  

 Expand „C/C++‟ -> „Editor‟ -> „Content Assist‟ 

 Uncheck all the options for „Auto Activation‟  


